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Tutorial Two: Introducing geometry using  
pattern blocks
In this lesson you will create a new project using the Kidspiration Pattern 
Blocks™ Math Tool. In the context of building designs with line symmetry, 
identifying and counting shapes, and modeling operations, you will learn to 
do the following:

•	 Start Kidspiration

•	 Start a new Kidspiration Pattern Blocks project

•	 Add your name to a project

•	 Save your work

•	 Use a Math Text Box

•	 Delete an object from the workspace

•	 Undo and redo your work

•	 Lock an item

•	 Create a password for the Teacher menu

•	 Move pattern blocks onto the workspace

•	 Use the Rotation tools

•	 Create a line of symmetry

•	 Resize manipulatives on the workspace

•	 Select multiple items on the workspace

•	 Add pages to your project

•	 Work with Math SuperGroupers

•	 Change the color of pattern blocks

•	 Duplicating items on the workspace

•	 Use the Cross-Out Stamp

•	 Lock a page

•	 Print your project

•	 Close your project and return to the Kidspiration Starter
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Starting Kidspiration

To start Kidspiration on a Macintosh:
•	 Open the Kidspiration 3 folder and double-click the Kidspiration icon.

	 The Kidspiration Starter opens.

To start Kidspiration in Windows:
•	 Click the Start button, point to Programs and click Kidspiration 3.
	 The Kidspiration Starter opens.
The Kidspiration Starter is the place where you start new projects, open 
existing projects and use the many different Kidspiration activities. You will 
begin by clicking the Math View button to open the Math Tool Starter.

Starting a new Kidspiration Pattern Blocks project
To start a new Kidspiration Pattern Blocks project, click the Pattern Blocks 
button on the Math Tool Starter.

A new blank workspace opens in the Kidspiration Pattern  
Blocks Math Tool.
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Adding your name to a project
1. 	On the Math toolbar, click the Student Name button .
2. 	Type your name in the box where indicated.
	 For the examples in this tutorial we will use the name “Glenna.”
3. 	To choose where you want the name to appear on the page, select Left, 

Center or Right.
	 A preview of how the name will appear on the page is displayed in the 

box on the right side of the dialog box.
4. 	Click OK.
	 The student name appears in the title bar of the document.

Saving your work
1. 	On the File menu, click Save.
2. 	In the folder list, click the folder where you want to save the project.
3. 	Type a name for the project, and then click Save.
	 Kidspiration suggests the name “Glenna” based on the student name, but 

you can use a different name.

Using a Math Text Box
Math Text Boxes allow students to describe their work with words, numbers 
and math notation, including structured frames for writing fractions, 
division problems and vertical math notations. Math Text Boxes also allow 
teachers to place instructions and helpful text in projects.
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1. 	Click the Math Text Box in the Math palette and drag it onto 
your workspace, positioning toward the top center.

2. 	Click inside the text box and write Line Symmetry, but follow the steps 
below so it looks like this: 

	 Note: If you make a mistake in your work, you have several options on 
the Math toolbar:
•	 You can delete an item by selecting it and clicking the Clear button

on the Math toolbar.

	 –or–
•	 You can undo up to the last eight changes in your project by clicking 

	 the Undo button on the Math toolbar.

	 –or–
•	 You can redo up to the last eight changes you used the Undo button to

 undo by clicking the Redo button on the Math toolbar. 

3. 	Enlarge the text size by clicking the Resize Text button on the 
Bottom toolbar once. 

4. 	Click outside the text box and then back on it to select it. When a text 
box is selected, it has corner handles .

5. 	Bold the text by clicking the Bold button  on the Bottom toolbar. 
6. 	Resize the text box by dragging on one or more of its corner handles so 

that all of the text fits on one line. 
7. 	Add a border and a background color to the text box by clicking the 

Border button  on the Bottom toolbar, and then the Background 

	 Color button next to it. 
	 Choose a background color from the palette.
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Locking an item on the workspace
Now that your Math Text Box is set up, you can lock it so that it cannot be 
moved or deleted. 
•	 With the text box selected, click Locked Item on the Teacher menu. 
	 A checkmark appears next to Locked Item when the text box is locked, 

and the corner handles change on the box.
	 Note: The Teacher menu must be enabled for the Locked Item option to 

appear. To turn the Teacher menu on or off, click Enable Teacher Menu 
on the Teacher menu. 

Creating a password for the Teacher menu
You can create a password for the Teacher menu to prevent students from 
using it and changing teacher preferences. 
1. 	On the Teacher menu, click Application Options.
2. 	Select the Password Enabled check box.
3. 	Click Set Password.
4. 	The Set Password dialog box appears.
5. 	Type the password you want to use in the Enter Password box.
6. 	Type the password again in the Confirm Password box, and then click 	

OK.
	 When you enable the Teacher menu, you will be prompted to enter your 

password.
	 Note: If you forget your password, you can access the Teacher menu by 

using the password “Kidspiration3.”

Moving pattern blocks onto the workspace
Now you’ll bring out some pattern blocks to create a design with line 
symmetry.
1. 	Click on the blue hexagon on the Math palette and drag it onto the 

workspace. Do the same with the red square and the yellow trapezoid. 
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2. 	Click twice on the green triangle on the Math palette to add two of 
them to the workspace.

3. 	Click and drag each pattern block into a pattern that looks like this:

	 Notice that the blocks “snap” together into position. 

Using the Rotation tools
Use the Rotation tools on the Math toolbar to rotate blocks on the 
workspace when building patterns, models and designs.
1. 	Drag two of the large purple rhombuses onto the workspace, one on 

either side of your pattern.
2. 	Click the rhombus on the left to select it, then click the Rotate Block 

Clockwise button on the Bottom toolbar twice.
	 Note: You can also rotate shapes on the workspace by selecting them 

and then clicking your spacebar to rotate them clockwise, or by holding 
the Shift key down and clicking your spacebar to rotate them counter-
clockwise.
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3. 	Drag your rhombus into position so that it “snaps” into place against the 
hexagon and the trapezoid.

4. 	Now select the rhombus on the right and repeat step number 3 above.
	 Your pattern should now look like this:

Creating a line of symmetry
You can use a line from the Math palette to reinforce the concept of 
symmetry in the Kidspiration Pattern Blocks Math Tool.
1. 	Click and drag a line from the Math palette onto the workspace.
2. 	With the line selected, drag on one of its handles while you hold down 

the Shift key, and move the line into a vertical position. (When you 
hold down the Shift key, you can drag a line sideways in 45 degree 
increments.) 

3. 	Drag the line over the middle of the pattern so it bisects it.
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4. 	You may need to lengthen the line so it extends a little beyond the top 
and bottom of the pattern. 

	 To lengthen the line, drag on one of its handles. Your pattern should now 
look something like this:

Resizing manipulatives on the workspace
You can easily resize manipulatives on the workspace to give your project 
more visual power. When you resize manipulatives, any lines on the 
workspace are also resized.
1. 	Click the Resize Manipulatives button on the Bottom toolbar once 

to enlarge your pattern on the workspace.

Selecting multiple items on the workspace
After you resize items, you may need to adjust their location on the workspace.

•	 Multi-select the pattern by clicking an area of open workspace and 
dragging your cursor over them. 

	 –or–

•	 Hold down the Shift key and click each item you want to select.

	 Tip: You can also turn Shift-select on, which allows you to select 
multiple items on the workspace without holding down the Shift key. 
Click the Shift-select button on the Bottom toolbar to turn Shift-select 	
on or off. The Shift-select button appears on Math View’s Bottom 	
toolbar when Stylus Mode is checked in Application Options on 	
the Teacher menu.
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2. 	Drag the pattern into position on the workspace so that your project 
looks like this:

Adding pages to your project
Math View allows for the creation of multiple pages within a single 
document, giving teachers the opportunity to create an extended activity 
with multiple parts, or students the opportunity to show their thinking using 
one or more tools. 
Now you’ll learn how to add two new pages to your project so you can 
continue working with Kidspiration Pattern Blocks.
1. 	Click the Go To Page button on the Math toolbar to open the 

Choose Page dialog.

2. 	Click the Add Page button  to add a new page.
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3. 	Choose Pattern Blocks from the Math Tool Starter, and repeat the 
process to add a third page also using Kidspiration Pattern Blocks.

4. 	Navigate back to page 2 by clicking the Go to Previous Page button 
on the Math toolbar. 

	 Note: When you have more than one page in a project, a page number 
for the page you are working on appears in the upper-left corner of the 
workspace.

Working with Math SuperGroupers
Math SuperGroupers are similar to the SuperGroupers in Picture View. They 
are used for grouping, sorting, categorizing and counting activities. Here 
you will use Math SuperGroupers for shape identification and counting.
1. 	Click and drag 2 rectangular Math SuperGroupers from the 	

Math palette onto the blank workspace on page 2, placing the first one 
toward the top center, and the second one toward the bottom center.

2. 	Click to select each one and drag on one or more of their corner handles 
to make them wide across the page. 

3. 	Notice that when you have a grouper selected, a label box appears in 
dotted lines at the top. 

4. 	Double-click inside the label boxes one at a time to select them and a 
cursor will appear. 

	 Type 5 blue hexagons into the first one and 4 green triangles into the 
second one. 
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5. 	Change the background color of one of the groupers to give your 
document visual interest. 

	 Select the 4 green triangles grouper and choose red from the Color 
buttons on the Bottom toolbar. 

6. 	Now that your groupers are ready, use pattern blocks to represent the 
labeled quantities. Drag 5 blue hexagons from the Math palette into the 
first grouper, and 4 green triangles into the second grouper.

	 Your project should look like this:

	 Note: Once manipulatives are placed inside a grouper, they will remain 
there until you remove them. Drag one of the groupers around the 
workspace and notice that the tiles move with it.

Changing the color of pattern blocks
1. 	Go to page 3 of your project by clicking the Go to Next Page button 

on the Math toolbar.
2. 	Represent six times four by placing four hexagons on page 3’s blank 

workspace. Do so by clicking the blue hexagon in the Math palette four 
successive times.

3. 	Click and drag each hexagon into a horizontal row across the workspace.
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4. 	Multi-select them and change their color to purple by clicking the purple 
Color button on the Bottom toolbar.

5. 	Click the Math Text Box  in the Math palette and drag it onto 
your workspace below the row of hexagons.

6. 	Click inside the text box and write 6 sides times 4 hexagons equals 24

	 total sides, using the Multiplication button  and the Equals button 
on the Bottom toolbar for the math operators. 

7. 	Click outside the box and then back on it. Resize the text box by 
dragging on one or more of its corner handles so that all of the text fits 
on one line. 

	 Your text box should now look like this: 

Duplicating items on the workspace
You can use Copy and Paste options to create another row of hexagons to 
represent a second math problem.
1.	  Multi-select the row of pattern blocks on the workspace and select Copy 

from the Edit menu. Place your cursor below the text box and click Paste.
2. 	Drag the new row into position so your project now looks something  

like this:

Using the Cross-Out Stamp
Use the Cross-Out Stamp to mark blocks and represent the subtraction 
expression, four minus two.
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1. 	Click away from the second row of hexagons and then multi-select the 
first two on the left.

2. 	Click the Cross-Out Stamp  on the Bottom toolbar to mark them for 
subtraction.

	 The 2nd row of hexagons should look like this:

3. 	Add another text box below the second row of hexagons. 
	 Write 4 hexagons minus 2 hexagons equals 2 hexagons, by typing text 

and clicking the corresponding math operators on the Bottom toolbar.

Locking a page 
The ability to lock pages in a document allows you to set up an example 
within an activity and prevent students from altering any of the items on the 
workspace, or adding to the page. Try locking page 3 to see how this works.
•	 While you are on page 3, click Locked Page on the Teacher menu.
	 A checkmark appears next to Locked Page when the page is locked, and 

a Locked Page indicator appears next to the page number.
	 Note: The Teacher menu must be enabled for the Locked Page option to 

appear. To turn the Teacher menu on or off, click Enable Teacher Menu 
on the Teacher menu. 

Page 3 of your project should now look something like this:
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Printing your project
To print a project, click Print on the File menu.
You can also choose from the following options before printing:

	 Selecting page orientation
	 In Math View, landscape orientation is the default. To switch to portrait 

orientation before printing a project:
1. 	On the File menu, click Page Setup.

2. 	Next to Orientation, click the Portrait or Landscape icon 
(Macintosh).

	 –or–

	 Under Orientation, select Portrait or Landscape (Windows).

Selecting paper size
	 Letter is the default paper size in Kidspiration. To select a  

different paper size:
1. 	On the File menu, click Page Setup.

2. 	In the Paper list, select the paper size you want (Macintosh).

	 –or–

3. 	Under Paper, select the paper size you want in the Size list 
(Windows).

Printing page numbers
	 If you choose to print page numbers, they will appear at the bottom of the 

page. To print page numbers:
1. 	Click the Student Name button.

2. 	Select the check box where indicated.
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Closing your project and returning to the Kidspiration 
Starter
Congratulations! You have completed Tutorial Two: Introducing geometry 
using pattern blocks. To close your project and return to the Kidspiration 
Starter, click the Go to Starter button.

When you return to the Kidspiration Starter, you are prompted to save the 
open project. Click Yes if you want to save the project. 
 


